chapter 7

Animation 101

This chapter dives into the heart and soul of Flash—which is, of course, animation. Just like in a flipbook, the process of animating your objects in Flash involves having them change in some manner from frame to frame. Animation can consist of a variety of changes to your objects as time passes. For example, your objects can move, change color, change shape, change size, and undergo a variety of other transformations as the animation is played.

There are two methods you can use to animate your objects in Flash: frame by frame and/or tweening. As the name suggests, frame-by-frame animation involves manually changing your objects on the Stage in each frame to create the illusion of movement or to change the attributes of an object over time. With the other method, tweening, which is short for “in between,” you specify the object’s starting point and its end point, and Flash creates all the objects “in between.” This chapter explores both of these methods of animation.

Understanding the Timeline

The Timeline that you briefly explored earlier in this book is of vital importance when it comes to animations. As its name suggests, the Timeline represents time as it passes in your animation. When you play your animation, Flash displays the contents of a frame, moving from left to right, across the Timeline. The Timeline is made up of little rectangles, each representing one frame in your animation; the number of frames in the animation is displayed at the top of the Timeline. The red line in the Timeline, called the playhead, indicates which frame is currently being displayed on the Stage.

Using the Timeline, you can assign special attributes to your frames, insert frames, change the type of frames, and control the speed at which the animation plays. You can also use the Timeline to create frames, which can be one of three types:

- **Keyframe.** Keyframes are the cornerstone of animations in Flash. They signify that something has either just been created or has changed. Imagine an animation that included a bird that flew from the left side of the Stage, stopped in the middle of the Stage, and then moved upward. In order to create this type of animation, you would need a keyframe at the point where the bird started; a keyframe in the center, where it changed direction; and a keyframe at the end, where it stopped. Whenever a change occurs in an animation, a keyframe is necessary.

- **Static frame.** A static frame displays the same content as the frame before it. In many animations, you’ll want the action to pause for a moment. To create these pauses, you use static frames.

- **Blank keyframe.** A blank keyframe is a completely blank frame in the Timeline.
Each layer that you create will have its own row of frames, which means you can animate objects on different layers independently. For example, say you create a keyframe on a particular layer. That keyframe will be applied to all objects on that layer, but will not affect objects on a different layer. Okay, enough theory, let’s get to animating.

### Creating Frame-by-Frame Animations

In frame-by-frame animation, you adjust the attributes of your objects—for example, their position, size, and color—on each individual frame of the animation. To accomplish this, you start by creating an object on the first frame (which will become the first keyframe) and then changing that object’s attributes in other frames.

1. Start by creating a ball for use in this animation—a circle with a radial gradient fill. (Make sure that the Object Drawing option is selected in the Options section of the Tools panel before you create the circle.) In Figure 7.1 I’ve created the ball along with a background image.
2. Notice the dot in the first frame of the Timeline. This dot indicates that this frame is a keyframe—in this case, because this is the frame in which the object was created. Position your mouse pointer over frame 2 in the Timeline and click once. You’ll notice that frame 2 is now highlighted in blue, as shown in Figure 7.2.

If you can’t remember how to make a circle with a radial gradient fill, refer to Chapter 5, “Transforming and Filling Objects.”
3. Right-click frame 2 and choose Insert Keyframe from the menu that appears, as shown in Figure 7.3. Frame 2 will remain selected, and all the objects in frame 1 will be copied to frame 2.

4. Right now, your ball and any background content you added are in both frame 1 and frame 2, in the exact same position. Because frame 2 is now a keyframe, you can change the position of the ball in that frame without affecting its position in frame 1. Using the Selection tool, move the ball in frame 2 slightly to the right, as shown in Figure 7.4.

5. Press the Enter or Return key on your keyboard to play your animation. You’ll notice that the sphere quickly moves from left to right. Wow! Your first frame-by-frame animation! That wasn’t so hard was it? Let’s continue the animation by repeating step 4 for the next three frames. When you’re finished and you play your animation, the ball should move from one side of the Stage to the other.

Creating Multiple Keyframes

In the animation you just created, you created your keyframes one at a time. To save yourself some time, you can create many keyframes at once. In this example I’ve used an image of a car moving across a background, but you can create the effect with any object.

1. Create an image in the first frame of the animation. A keyframe will automatically be created in that frame, because it is the first frame that contains the image.

2. Click and drag across the frames in the Timeline that you would like to convert to keyframes. When you release the mouse button, they will all be highlighted, indicating that they have been selected.

3. Right-click any of these selected frames and choose Convert to Keyframes from the menu that appears (see Figure 7.5). All the selected frames will now be keyframes, and the object that you placed in the initial frame will be copied to each selected frame.
4. Click frame 2 in the Timeline to select it.
5. On the Stage, move the object in frame 2—in this case, the car—slightly to the right, as shown in Figure 7.6.
6. Repeat this step for the rest of the keyframes, moving the object progressively farther to the right.
7. Press the Enter or Return key on your keyboard to play the animation and watch your object move across the screen.

Adding, Copying, and Pasting Frames

Earlier, you created an animation that had only two frames. Most animations that you create, however, will have dozens, if not hundreds of frames. In this section, you’ll create a pair of cartoon eyes that consist of two eyeballs and two pupils, and then generate a frame-by-frame animation with many different frames to move the pupils around. In the process, you’ll learn to add frames, as well as copy and paste them—which is useful when you want to repeat actions in your animations without having to re-create them.

1. Start by creating a new Flash animation that contains eyeballs and pupils, as shown in Figure 7.7. (I’ve created an entire face here, but for this exercise, you need only create the eyes.) The eyeballs are ovals with radial gradient fills, and the pupils are simply smaller black circles. Make sure that the Object Drawing option is selected in the Options section of the Tools panel before you create the circles.
2. While pressing the Shift key, use the Selection tool to click both of the pupils.
3. With both pupils selected, press Ctrl+G to group them together. That way, you can animate them both at the same time.
4. Right-click frame 5 in layer 1 and choose Insert Keyframe from the menu that appears. (You are choosing frame 5 because you don’t want the action to happen instantly; rather, you want a little bit of a pause before you make the pupils move.) The eyeballs and pupils will be copied on every frame between frames 1 and 5. You will also now have a keyframe on frame 5, where you can adjust the position of the pupils without affecting their position on any of the previous frames.

5. When you create a keyframe, all the objects on that layer will be selected. Click any blank area of the Stage to deselect the objects.

6. Click and drag the pupils all the way to the left of the eyeballs, as shown in Figure 7.8. This will make the pupils move when the object is animated.

7. Press the Enter or Return key on your keyboard to play the animation that you’ve created so far. You should see that after a third of a second, the pupils jump from the center of the eyes to the left.

8. Next, you’ll get the pupils to jump back to the center of the eye after another third of a second goes by. To begin, right-click frame 10 in layer 1 and choose Insert Keyframe from the menu that appears.

---

**Figure 7.7** Create two cartoon eyes, as shown here, by making two ovals and two circles.

**Figure 7.8** By positioning the pupils all the way to the left of the eyeballs, you create the illusion of movement.

When you create a keyframe, all the objects in the previous keyframe get copied onto the frames in between. For example, if you create a circle on frame 1 and then create a keyframe on frame 100, every frame between frames 1 and 100 would also contain that circle. Because there is no action in these frames, when you play the animation, it will appear as though nothing is happening, or that the action is paused. The number of frames between the two keyframes will determine the length of this pause.
9. Now click in any blank area of the Stage to deselect the objects.
10. Position the pupils back in the center of the eyes, and then press the Enter or Return key to watch the animation that you’ve created up to this point. What you should see now are the pupils moving left and then back to the center.
11. Say you want to lengthen the time between the pupils moving. In other words, rather than having the pupils move after only a moment, you want the pupils to start in middle, stay there for three seconds, and then move to the left, where they’ll remain for three more seconds before moving back to the center. To accomplish this, you simply need to add frames between the keyframes you created earlier. To begin, click any frame on your Timeline between the first keyframe (frame 1) and the second keyframe (currently frame 5). The frame you click will be highlighted, as shown in Figure 7.9.
12. Press the F5 key about 30 times. Each time you press F5, one additional frame will be added to the Timeline. You should notice that as you add frames, the keyframes after the selected frame are moving farther down the Timeline. Each of the frames that you add will be static frames, and will contain the objects that were on the keyframe before them.
13. Select any frame between the second and last keyframe, and repeat step 12 to insert additional frames (see Figure 7.10). Your Timeline should now be quite a bit longer. Press the Enter or Return key to watch your animation; you should notice that the pupils pause in each of their new locations a lot longer than before.
14. The next step of your animation is to have the pupils move in the other direction. Right now, they move from the center to the left, and then back to the center. You want to add more frames so that after the pupils move back to the center, they will move to the right and then back again. Rather than having to re-create these movements and make all new keyframes, however, you can copy and paste your existing frames. To begin, position your mouse pointer over frame 1 in the Timeline, click, and drag to the right until the last keyframe is highlighted, as shown in Figure 7.11. All the frames in your animation are now selected. (Another way to select all the frames in your animation is to press Ctrl+Alt+A.)

15. Open the Edit menu, choose Timeline, and select Copy Frames. The frames that you selected will be copied to the system clipboard and can now be pasted elsewhere.

16. Click the first blank frame, which is directly after the last keyframe in the Timeline, as shown in Figure 7.12.

17. Open the Edit menu, choose Timeline, and select Paste Frames to paste all the frames you had on the clipboard into the Timeline.

18. If you played the animation now, you’d see the pupils looking to the left twice. You need to change the second instance of the pupils moving to the left so that they are moving to the right. To begin, click the keyframe in the Timeline that begins the second instance of the pupils moving to the left and drag to the right to select the frames.
19. Click on the frame that contains the second-to-last keyframe. Because all the objects on the Stage are still selected, you’ll need to click any blank area to deselect them. Then click and drag the pupils to the right side of the eyeballs, as shown in Figure 7.13. Just changing this one keyframe changes the direction of the pupils’ movement.

20. Press Ctrl+Alt+R to move the playhead to the beginning of your animation, and then press the Enter or Return key on your keyboard. What you should see are the pupils starting in the center, moving to the left, returning to the center, moving to the right, and then going back to the center. By adding frames, copying, and pasting, you’ve managed to create pauses and extend your animation.

Flash Animation for Teens

Removing and Clearing Frames
Flash gives you several options for getting rid of content in your animations. To clear or remove frames, do the following:

1. Select the frames in the Timeline that you want to clear or remove by clicking and dragging across them.
2. Right-click the selection or an individual frame and choose Clear Frames or Remove Frames from the menu that appears to remove objects from the selected frame but leave the frame in place or to remove the frame and all of its contents, respectively.

So far, we’ve stuck to using movement for your frame-by-frame animations, but don’t think that’s all you can do! In addition to moving elements frame by frame, you can do all sorts of other wonderful things to your objects, including changing their colors, reshaping them, or replacing them with other objects.
Using Flash’s Onion Skin Feature

So far, when you’ve created your frame-by-frame animations, you’ve simply roughly moved your shapes around. Rather than having to guess where to move objects on the Stage when creating animations, however, you can use the Onion Skin feature to help you get an understanding of what’s going on in your animation before and after your current frame. The Onion Skin feature makes your frames partially see-through so that you can tell what happened in the frame or frames before and after. (This feature is called “Onion Skin” because actual onion skin is partially see-through and layered, not unlike the frames in Flash.)

1. Create an object and use it to make a frame-by-frame animation on the first 10 frames of your Timeline, moving the object to different locations on the Stage in each frame. For example, have your object move from left to right across the Stage.
2. Click frame 5.
3. Click the Onion Skin button. In addition to seeing your object at its position in frame 5, you should see a translucent view of the object’s position in a few of the frames before and after the current frame (see Figure 7.14). You can now move your object around precisely, knowing exactly where your object will be in relation to the objects in the frames before and after it.
4. If you take a close look at the Timeline header, you’ll notice two interesting shapes surrounding the currently selected frames. These shapes indicate the number of frames you can see through. To increase or decrease the number of frames that show through, position your mouse pointer over one of these shapes and click and drag inward (toward the playhead) or outward to decrease or increase the number of frames that show through, respectively (see Figure 7.15).

Figure 7.14 Click the Onion Skin button to see some of the frames before and after the current frame.

Figure 7.15 You can drag the Start Onion Skin and End Onion Skin markers to adjust how many frames are shown.
In addition to using the Onion Skin feature to track your animation over several frames at once, you can use it to trace objects. This is particularly useful if you want to trace a photograph. Simply place the photograph on one frame and turn the Onion Skin feature on in the next frame. You can now trace the image, as shown in Figure 7.16, and then delete the first frame.

**Onion Skin Options**

You can control a variety of options for Flash’s Onion Skin feature. Click the Modify Onion Markers button to display a menu of options (see Figure 7.17):

- **Always Show Markers.** Select this option to always show the Onion Skin markers, regardless of whether the Onion Skin feature is turned on or not.
- **Anchor Onion.** This setting locks the markers in their current location so that they cannot be moved. To turn this feature off, click this option in the menu again to deselect it.
- **Anchor 2.** This setting places the Start Onion Skin and End Onion Skin markers two frames before and after the current frame, respectively.
- **Anchor 5.** This setting places the Start Onion Skin and End Onion Skin markers five frames before and after the current frame, respectively.
- **Onion All.** This setting positions the Start Onion Skin and End Onion Skin markers around the first and last frame of your animation.

The marker positions for the Onion Skin are relative to the current frame. That means that you’ll have to set the markers individually for each frame.
Reversing Frames

The ability to reverse frames can be a huge time-saver in Flash. For example, imagine you’ve created an animation of a ball flying up in the air. Rather than having to create the frames for the ball falling back down to Earth, you can copy the original frames, paste them, and then reverse them. Reversing a selection of frames switches them around so that the last frame appears first and the first frame appears last. Sound confusing? It isn’t really, just follow these steps:

1. Create a frame-by-frame animation that contains half the action you want to include—for example, a ball moving upward, eyes moving in one direction, or a character jumping. The example I use here shows a frame-by-frame animation with four frames of a seal that has a ball moving upward.
2. Click and drag across the frames that include the animation you want to reverse in order to select them.
3. Open the Edit menu, choose Timeline, and select Copy Frames to copy the selected frames, as shown in Figure 7.18.
4. Click the first empty frame in the Timeline and then open the Edit menu, choose Timeline, and select Paste Frames, as shown in Figure 7.19. The copied frames will be pasted into your Timeline, the result being that your animation will basically repeat itself. Your next step is to reverse the frames you just pasted.
5. Click and drag across the frames that you just pasted in order to select them.
6. Open the Modify menu, choose Timeline, and select Reverse Frames to reverse the frames.
7. Press Enter or Return to play the animation. You should notice that the frames you pasted play in reverse.

Figure 7.18 Copy the frames that include the animation that you want to reverse.

Figure 7.19 Paste the copied frames into the Timeline. The Timeline should look like this when you are finished.
Imagine that you want to create a five-minute animation. Using Flash’s default settings, you’d have to create more than 3,500 frames. Although you could create this type of animation frame-by-frame, why would you want to? The folks who developed Flash understand this, which is why they give you the option of using tweening. *Tweening* allows you to create a starting point and an ending point for an object, and let Flash create all the objects in between. Believe me, once you really get into animating, tweening will be your new best friend because it will save you so much time. Even if you were making a simple animation—of, say, a tire moving across the Stage for several seconds—using the frame-by-frame technique would require you to manipulate more than a dozen frames, one by one. By using tweening, however, you would need to adjust only two frames—the one that represented the tire’s starting point and the one that represented its end point.

**Motion Tweening**

The first type of tweening this chapter is going to explore is *motion tweening*. With this type of tweening, you can use just a few clicks of the mouse button to create an object and have it move to a new location on the Stage; Flash will do the rest.

1. On a separate layer in the first frame, create the object you want to animate.
2. Press Ctrl+F3 to open the Property inspector if it is not already open.
3. I want to make this animation 20 frames long. To do so, right-click frame 20 in the same layer and select Insert Keyframe from the menu that appears. The shape you created will be copied to all the frames after frame 1 up to frame 20.
4. Click frame 1. Then, in the Property inspector, open the Tween drop-down menu and select Motion, as shown in Figure 7.20. Believe it or not, you’ve just created a motion tween—although if you ran the animation now, nothing would happen because you haven’t moved the object to its end point yet. Once you’ve selected the Motion option, an arrow will appear in the Timeline between the first and last frames.
5. Click frame 20 and move your object to another location on the Stage.
6. Press the Enter or Return key to play the animation; the object will move across the Stage, starting at its position in frame 1 and ending at its position in frame 20 (see Figure 7.21). Isn’t motion tweening great? In just a few steps you can make objects fly across the Stage!
Using the Orient to Path Option

In the motion tween you created in the last section, the object moved in a straight line from its original position to the position where you moved it. Most objects in real life, however, don’t travel in a straight path. Consider a bird, for instance—birds don’t typically fly in a straight line. Likewise, if you wanted to create an animation of a bird, you’d want it to fly to different locations on the screen, in all different directions. To achieve that effect, you can use the Orient to Path option. The same goes for a car on an oval track—you’d want to circle the track rather than simply drive in a straight line. To dictate an object’s path, do the following:

1. Start by creating a motion tween, as you did in the preceding section.
2. Click the frame where the animation starts.
3. In the Property inspector, click the Orient to Path checkbox to select it.
4. In the Layers area on the Timeline, click the Add Motion Guide button. A motion guide will be added to this layer, and will appear as a guide layer in the Layers area (see Figure 7.22).
5. Click the Pencil tool and draw a path on the Stage; your animation will move along the path you draw. (Note that you could also use the Pen, Line, Circle, Rectangle, or Brush tool here.) You can make this path a curved or squiggly line, or even a shape or pattern. In this example, shown in Figure 7.23, I drew a path that goes around a track. (My path is red, but it really doesn’t matter what color you make your path because you will hide it in the following steps.

6. Click the Selection tool and move the object so that it is centered on the start of the path, as shown in Figure 7.24.

7. Click the last frame of the motion tween.

8. Position the object on the last frame so that it is centered on the end of the path, as shown in Figure 7.25.

9. Click the guide layer’s Hide Layer button to hide the path, as shown in Figure 7.26. (Even if you don’t hide the path, it won’t appear in your final exported animation.)

10. Press the Enter or Return key to play the animation. The object will follow along the path as the animation plays.

**Figure 7.23** You can create any type of path for your motion tween, including lines and shapes.

**Figure 7.24** Position the object so that it’s centered on the beginning of the line.

**Figure 7.25** Position the object in the last frame so that it’s centered at the end of the path.
Using Flash’s Ease Function

Visualize a sprinter running a 100-meter race. When the starting gun fires, the sprinter explodes out of the blocks and increases his speed until he maxes out, maintaining this maximum speed until he crosses the finish line. Then, after he crosses the finish line, the sprinter slows down until he stops. All this is to say that the sprinter’s speed changes at the beginning and at the end of the race. That’s pretty much how the Ease feature works in Flash. With this feature, you can increase the speed of the animation of the object to be faster at the beginning and/or at the end of the animation.

To use this feature, first create an animation using a motion tween. When you do, you’ll notice an Ease drop-down arrow in the Property inspector. Click it to display a slider bar that you can drag up or down to increase or decrease the Ease level respectively, as in Figure 7.27. A higher Ease value makes the object travel more quickly at the beginning of the animation, and a lower value speeds the object up at the end of the animation.

Figure 7.26  Hide the path so that you won’t see it as the animation plays.

Figure 7.27  You can use the Ease slider to adjust the speed of the animation at the beginning or end of the tween.
Rotating Your Animation

Not only can you make objects move from one location to another using the motion tween, you can make objects rotate as they move across the Stage. Here’s how it’s done:

1. After creating a motion tween, click the first frame and open the Rotate drop-down arrow in the Property inspector. As shown in Figure 7.28, a variety of options from which you can choose will appear, including the following:
   - **None.** If this option is selected, no rotation will occur.
   - **Auto.** If this option is selected, the object will rotate once as it moves.
   - **CW.** If this option is selected, the object will rotate in a clockwise direction.
   - **CCW.** If this option is selected, the object will rotate in a counterclockwise direction.

2. Type the number of times you want the object to rotate in the Times box. (This option is only available if you select the CW or CCW option.)

3. Press the Enter or Return key and watch your object rotate as it moves across the screen.

Rather than pressing Enter or Return to play your animations in order to preview the changes you have made, you can drag the red playhead in the Timeline. As you drag the playhead forward or backward, the frames will change on the Stage, allowing you to preview your animation.
Shape Tweening

The shape tweening feature allows you to change an object's shape over time without having to edit the shape frame by frame. Using shape tweening, you create a starting object and an ending object, and Flash creates all the transitional shapes in between. This is particularly useful for animating facial expressions, moving body parts, and morphing objects. In this example, I’ll show you how to morph a circle into an interesting shape. As it morphs, we’ll also move the shape and change its color. Here’s how it’s done:

1. Make sure the Object Drawing option is enabled. If it is not, press the J key on your keyboard to enable it.
2. Draw a circle of any color on the Stage in frame 1 and position it on the left side of the Stage, as shown in Figure 7.29.
3. Right-click frame 20 and select Insert Keyframe from the menu that appears. You now have a 20-frame animation with no action—yet.
4. Click frame 1, open the Tween drop-down menu in the Property inspector, and select Shape, as shown in Figure 7.30.
5. Click frame 20 and then click the Subselection tool to activate it.
6. Click the circle and drag it to another location on the Stage.
7. Click the circle’s outline to display anchor points that you can use to reshape the circle.

Figure 7.29 You are going to transform this circle using a shape tween.

Figure 7.30 Create a shape tween by selecting Shape from the Tween drop-down menu in the Property inspector.
8. Click and drag on any of these anchor points to give the circle a new shape.

9. Apply a new fill color to the shape. The shape that you end up with is what the object will morph into when the animation plays (see Figure 7.31).

10. Press the Enter or Return key to play the animation. You should notice that the circle morphs into the interesting shape that you created.

If you want to remove a shape tween or motion tween from your animation, right-click any frame within the tween and choose Remove Tween from the menu that appears.

Now You Try
Try to create an animation that has a cartoon face going from happy to sad, as in Figures 7.32 and 7.33. If you get stuck, follow the steps in this section to see how this is done.

1. Create a cartoon character similar to the one you see in Figure 7.32, but leave out the mouth. I used the Pencil tool, Brush tool, and Paint Bucket tool to create my character. Don’t worry if your character doesn’t look exactly like this one; just try to get close.

2. Rename the layer with the cartoon character “Background” to help keep things organized.

3. Create a new layer and call it “Smile.”

4. On the Smile layer, use the Pencil tool to create the character’s smile, as shown in Figure 7.34. (Make sure that you create the smile on its own layer—this is very important. If you don’t, you can create a real mess, as you’ll see in the next section. Also, be sure to draw the smile with the Pencil tool.)

5. Right-click frame 15 in the Background layer and choose Insert Frame from the menu that appears. Notice that you are not creating a keyframe, just a regular frame. You don’t need a keyframe because you won’t be changing the background at all during the animation. The background you created will be copied to every frame in your animation, ending with frame 15.
Figure 7.33 Through shape tweening, you'll turn the smile into a frown over 15 frames. The beauty of this technique is that you'll need to change the smile only on one frame—the last one. Flash will do the rest!
6. Click the Smile layer to select it.
7. Right-click frame 15 and choose Insert Keyframe from the menu that appears. The smile you created will be copied to every frame in your animation, ending with frame 15.
8. Click frame 1 in the Smile layer to select it. Then, in the Property inspector, open the Tween drop-down menu and select Shape, as shown in Figure 7.35. The smile is now a shape tween.
9. Click frame 15 in the Timeline and use the Free Transform tool to select the smile. A series of handles will appear around the smile.
10. Position the mouse pointer just outside any of the corner handles until the mouse pointer changes into a circle with an arrow, click, and drag until the circle rotates into a frown.
11. The frown will be off center, so click the smile and drag it to the middle of the face, as shown in Figure 7.36.
12. That’s it! You’ve completed your animation. Just press the Enter or Return key and watch the smile morph into a frown.
Shape Tweening Different Shapes

When you first created a shape tween you created an image in the first frame and then altered it slightly for the last frame. With shape tweening you can create more outrageous morphs, involving two completely different shapes. In this example I’ll make a caterpillar turn into a butterfly using a shape tween, but you can create any type of object.

1. Create an object for the first frame of your shape tween. In this case, I created a caterpillar, as shown in Figure 7.37.
2. Right-click frame 10 and choose Insert Keyframe from the menu that appears. You’ll now see the caterpillar on this frame, and it will be selected. Press the Delete key on your keyboard to remove the caterpillar.
3. Create or import another object onto this frame. In this case, I copied a butterfly onto the frame, as shown in Figure 7.38.
4. Click the first frame, open the Tween drop-down menu in the Property inspector, and select Shape, as shown in Figure 7.39.
5. Play your animation. You’ll see your object transform. In this case, the caterpillar morphs into a butterfly.

Figure 7.37 Create your object in the first frame.

Figure 7.38 Create or import an object on the last frame.

Figure 7.39 After you select Shape from the Tween drop-down menu, the caterpillar will morph into a butterfly when the animation is played.
Using Shape Hints

If you play around with shape tweening, you may notice that the transition from one shape to another sometimes gets a little jumbled in the middle, or that it may not go exactly as you expected. To help you control how one shape transitions to another, you can use shape hints. Shape hints allow you to specify start points and end points for particular parts of a shape. This is especially useful for facial expressions in cartoons, for moving arms and legs, and for opening and closing mouths. Shape hints are also useful if you want certain objects to stay in place during the transition. To use shape hints, you place a shape hint in the start frame and then match it with a shape hint in the end frame.

1. Create a shape tween. In this example, I’ve created two simple characters figure skating.
2. When I play this animation, I notice that the animation seems jumbled in the middle frames, as shown in Figure 7.40.
3. Click the first keyframe of your shape tween to select it.
4. Open the Modify menu, choose Shape, and select Add Shape Hint. (Alternatively, press Ctrl+Shift+H.) A red dot will appear on the Stage with the letter “a” in it, indicating the presence of a shape hint.
5. Click and drag this shape hint to the first point on the shape that you would like to mark. In this example, I put the first marker on top of the figure skater’s head, as shown in Figure 7.41. I chose the top of the skater’s head because when I played the animation, the head got jumbled in the frames in between.

Figure 7.40  The middle frames in the shape tween can often become jumbled.

Figure 7.41  Position the first marker at the point where you would like to add a shape hint.
6. Click the last frame of the shape tween. You’ll notice that the red dot also appears on this last frame with a corresponding letter “a” in it. Position the red dot at the point in the shape corresponding to the first “a” marker, as shown in Figure 7.42.

7. Click the first frame of your shape tween. You’ll notice that the marker is now yellow. If you again clicked the last frame of the animation, you would notice that the marker is now green.

8. Repeat steps 3–6 for other locations on the shape, as shown in Figure 7.43. For example, put a marker on each hand, each foot, and in the middle of the shape. Each marker you create will be assigned a new letter so that you can match the marker on the first frame of the shape hint with the marker on the last frame. You can create up to 26 markers—one for each letter of the alphabet.

9. Play the animation; you’ll see a much smoother transition.

You don’t have to create a marker in the first frame and then position it in the last frame one at a time. To save time, you can create all your markers in the first frame and then move to the last frame and position them all.

Figure 7.42 Position the marker in the last frame at the spot corresponding with the first marker—in this case, the top of the head.

Figure 7.43 Add other shape hints to your shape as seen here.
Shape Tweening Options

If you click any frame in a shape tween, you’ll notice that several options appear in the Property inspector. One of these options, Ease, you’ve already explored. The other option, Blend, controls the process of the transition.

If you open the Blend drop-down menu, you’ll notice two options:

- **Distributive.** This option creates an animation in which the shapes between the first and last frame are irregular.
- **Angular.** This option creates an animation that keeps the straight lines and corners of the shapes between the first and last frame.

The difference between these blending options can be very subtle, so experiment with both to see which works best for you.

Timing

The whole process of animating involves showing a frame for a specific period of time (usually just a split second) before the next frame is displayed. The quicker a frame is displayed, the faster the animation will be. Flash allows you to control the timing of your animations to speed them up or slow them down. Be aware, however, that you can have only one frame rate for your entire animation. In other words, you can’t have it go faster or slower at different points (although there are animation tools you can use to make it *seem* like it’s going faster or slower).

1. Create any kind of animation and click any frame within the animation.
2. Look at the bottom of the Timeline; you’ll notice three numbers, as shown in Figure 7.44. The first number indicates your current frame, the second number is the speed of your animation represented in fps (frames per second), and the last number indicates how much time has elapsed.
3. The default number for your frame speed 12fps, which is ideal for animations made for the Internet. You can, however, change this number. To begin, open the Document Properties dialog box by displaying the Modify menu and choosing Document.
4. In the Document Properties dialog box, adjust the value in the Frame Rate field to change the fps, as shown in Figure 7.45.

Figure 7.44 The three numbers in the bottom of the Timeline indicate different aspects of the timing of your frame.

Figure 7.45 The Document Properties dialog box allows you to change the frame speed for your animations.
What is the secret to a great animation? The secret to great animation is a great story. Flash can enable you to tell a great story through animation, but without a good foundation, no amount of technology will help you. There are many different types of animation effects such as frame tweening, multi-layered movement, background animations, and my favorite, trick animations. Trick animation involves using still imagery, with quick cuts of images to give the illusion of speed and drama. A good example of this can be seen in the cartoon series *Teen Titans* or *Dexter’s Laboratory*. Oh yeah, and lots of pre-planning prior to executing.

Are there any animation tips you can share with our readers? There are many different types of animation, as I stated above. Today, many developers use ActionScript code to move elements around the Flash environment. Frame tweens can be a great enhancement to your animations as well. My advice would be to explore the space—start with a basic story and see how you can use a combination of code-based animations and tween-based animations, and you will quickly find the method that works best for you.

Do you have any other advice for teens getting started with Flash animations? My biggest piece of advice is to EXPERIMENT. Try to find different ways to do the same thing. You will quickly learn the program. Put down this book right now, go to your computer, and try to create an animation about a bird chasing a bug, a boy walking a dog…anything. As soon as you begin, you will instantly start learning about different ways of telling the same story. The Flash message boards are also a fantastic resource to gain and share knowledge, insights, tips, and tricks, and to show off your latest creations no matter how elementary they may be. Most of all, have fun. Good luck!
PRO • FILE

Name: Joe Shields
Organization: No. None at all. You should see my desk.
URL: http://www.joecartoon.com

How did you learn Flash? A friend of mine taught me. Brad Yarhouse. We worked together at a children’s apparel company as designers. He taught me the basics, and that’s all I know. His site is http://www.yarhouse.com. I’m a big fan.

How did you get started using Flash? I used to rent an office downtown. Way back in 1997, a 17-year-old computer geek from down the hall took one of my designs (it was two side-by-side drawings of an alien doing the pelvic thrust) and made a GIF animation out of it. I took one look at it and a big fat light exploded in my head. I was an animator and I didn’t even know it. I called up Brad and begged him to teach me.

What feature or tool do you use most often? The Pen tool. I draw a lot of pictures.

What do you like best about Flash? It’s easy to use and one guy can make a movie by himself if he wants to.

What sets your animations apart from others? My own personality. It’s definitely made, for better or worse, by one guy. I think people can tell. My work has a home-made feel to it—at least, that’s what I think. It ain’t exactly Disney, now is it?

What is the secret to a great animation? For me, it has to be funny. So I go for what makes me laugh. If you try to make it according to what you think other people will respond to, you’re sunk. Stay true to you.

Are there any tips that you can share with the readers about using Flash? I use flash at its most basic level. I draw frame by frame a lot and throw in an occasional button. For me, it’s that simple.

Are there any animation tips you can share with our readers? If you have to draw a lot of frames with a similar object—for me, it is mouths—fill one color at a time frame by frame. Then start over with the next color at the beginning. Why? When you have that many frames, its faster to fly from frame to fame with the Fill tool once than it is to select the Fill tool three times, frame by frame. (My mouths are three colors at most—two reds and white.)

Do you have any other advice for teens getting started with Flash animations? Yeah. You have a brain. You have thoughts in there that are yours, and I bet a lot of people could relate to them. So stay true to yourself whether it be funny, sad, serious, whatever. Don’t let the bubble poppers tell you that you can’t. And when the whole world is barkin’ at your door because they love what you did, tell ‘em the Joe-man sent you.
Samples

[Image of various cartoon characters and scenes]